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Introducción 

SeaClear es un graficador de cartas para PC. Cuando está conectado a un GPS, graficará la posición actual del barco
sobre una carta, los datos de dicha posición actual, velocidad, rumbo y mucho más. 

Las cartas en SeaClear son del tipo raster y pueden ser cartas BSB/KAP y GEO/NOS,  comercialmente disponibles, o
creadas de las originales de papel o pantalla. 

La carta se mueve para mostrar siempre la posición del barco y se van cargando nuevas cartas a medida que se
necesiten, cuando se selecciona la carga automática de las mismas. 

Las rutas pueden crearse fácilmente y usarse para asistir en la navegación. 

Las derrotas (tracks) pueden ser graficadas, grabadas en un archivo y convertidas en rutas. 

Los waypoints (puntos de posición) de las bases de datos de posiciones pueden ser usados para encontrar rápidamente
lugares con significancia especial o para crear rutas. 

Un menú emergente, que permite acceder a la mayoría de las funciones del programa, aparece presionando el botón
derecho del mouse (ratón), manteniendo la mayor parte posible de la pantalla para graficar las cartas. 

Un panel general ("dashboard") con información muestra los datos recibidos del GPS, la ruta actual y otras
informaciones de estado. Para maximizar el área de pantalla para las cartas el panel puede removerse temporariamente. 

Muchas funciones pueden controlarse con dicho panel. En modo manual contiene un menú superior que provee acceso
rápido a muchas funciones. 

Si no se dispone de datos del GPS, un panel "DR" (nota del traductor: por Dead Reckoning, que se refiere al cálculo de
la  posición del barco) permite la introducción manual de la velocidad y el rumbo reemplazando al panel GPS. Si los
datos NMEA de velocidad o rumbo están disponibles se actualiza el panel DR en forma continua. Los cálculos de DR
se realizan para obtener la posición actual del barco. 

La forma del cursor del mouse (ratón) muestra el modo de operación actual. 

La barra de título muestra el nombre de la carta actualmente graficada, el nivel de aumento (zoom) y la distancia de los
anillos de radar. 

La mayoría de la información puede imprimirse. Todas las listas pueden grabarse en disco desde la ventana de
previsualización.

 

Nota: Todas las referencias a SeaClear o a MapCal en este documento se refieren a los ejecutables SeaClear_2.EXE y MapCal_2.EXE. 
Los nombres fueron cambiados para permitir la coexistencia con versiones previas de SeaClear. 
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Pantalla
  

Area de carta 

      

   Nota: marca de posición = Waypoint 
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Panel de datos ("dashboard") 

Menú superior.

Estado del GPS. El menú se torna rojo si no hay datos del GPS.
Latitud.
Longitud.
Derrota verdadera sobre el fondo marino.
Velocidad del barco en relación al fondo marino.
Variación magnética computada.
Tiempo UTC reportado por el GPS.

Registro de la distancia recorrida acumulada basado en el GPS.
Distancia recorrida del viaje actual.
Contador de horas.
Acceso a la base de datos de posiciones (waypoints).
Seleccionar un waypoint.

Encontrar el waypoint sobre la carta. Carga una si es necesario.

Acceso rápido a las rutas.

Estadísticas de la ruta cargada.

Display de profundidad. Sólo con un transductor de profundidad NMEA.
Se torna rojo para indicar la alarma de profundidad.

Información del viento. Necesita un transductor NMEA.
Dirección y velocidad verdaderas del viento.
Dirección relativa y geográfica del viento.
Velocidad paralela al viento.

Compás magnético.
Sólo disponible con un compás con transductor NMEA.

Seleccionar entre medir o centrar al hacer doble click con el mouse
sobre la carta.

Seleccionar el nivel de sombreado.

Click para seleccionar / deseleccionar el modo automático.
Click para seleccionar / deseleccionar el grabado de la derrota.
Con una ruta activada: click para ON/OFF la salida de datos NMEA.

Cursor / Medición / Marca de posición, dirección y distancia.
Al medir, el color es verde claro.
Cuando se marca una posición, el color es celeste.

El que se muestren o no todos los paneles de información depende de los dispositivos NMEA que estén conectados.
Asimismo el tamaño de la pantalla puede limitar la presentación de los datos disponibles. Para mostrar todos los
paneles de información es necesario una pantalla con resolución de 1024x768. Los paneles solamente se mostrarán si
hay espacio disponible. 
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Planeando con SeaClear 

La navegación asistida por computadora tiene numerosas ventajas. Como la PC puede llevarse fuera del barco, muchas
de las tareas de planeamiento pueden hacerse de antemano. Las cartas y áreas de interés pueden ser digitalizadas, las
posiciones de importancia pueden grabarse y las rutas pueden planificarse cuidadosamente. 

Moviéndose con SeaClear 
Durante el planeamiento debería estar deshabilitado el modo Automático. De este modo el cursor se transforma en una

cruz.  
La posición y localización actual del cursor en relación al barco se muestra en el panel. 
Para mover la carta cargada se debe hacer click en cualquier parte de la misma y arrastrar el mouse. La carta completa
se mueve. En el modo "Center" (centrar), haciendo doble click se carga la mejor carta para la posición en que se
encuentra el cursor o, si la carta actual es la mejor, ésta se centra para la posición en que se encuentra el cursor, con el
fin de permitir moverse rápidamente. 
Si se tiene un mouse con ruedita, la ruedita puede usarse para ampliación rápida (zoom). La ampliación se centrará
alrededor de la posición del cursor del mouse (ratón). 
Haciendo click con el botón derecho del mouse y seleccionando "chart"(cartas) del menú, se puede recorrer el listado de
cartas y elegir cualquier otra. 

Cuando el cursor alcanza el borde de la pantalla adquiere flechas,      indicando que se encuentra en el modo de
localización de cartas. Cuando se hace doble click en el borde de la carta siempre se cargará una nueva carta, aunque
sea de una escala menor. Esto también se aplica en el modo de medición o edición de rutas. 

Haciendo click sobre el panel de estado del GPS se centrará en la pantalla la posición GPS actual. Si la posición del
barco está fuera de la carta actualmente cargada se cargará la mejor carta. El hacer doble click sobre la carta cargará la
mejor carta. 

El doble click sobre la carta  también puede medir distancias y marcaciones cuando se selecciona en el panel
("dashboard"). En el modo de medición, se debe hacer doble click con el botón izquierdo del mouse en un punto de
partida y manteniendo el botón apretado mover el cursor. La distancia y marcación se mostrará en el panel
Mark/Cursor. En el modo automático la medición mediante el doble click está activada siempre. 

Si se selecciona una posición y se hace click en el botón "Find Position" (encontrar posición) se mostrará en la carta. Si
dicha posición está en la carta actualmente cargada se centrará en ella, si no se cargará la mejor carta y se centrará en
esa posición. 

Además de recorrer el listado de waypoints (posiciones), las posiciones de interés pueden guardarse y usarse para crear
rutas. Como las rutas pueden unirse, una colección de rutas cortas también puede servir para hacer viajes más largos. 

Las rutas, posiciones y otras informaciones pueden imprimirse o guardarse como archivos de texto. Todos los listados
son grabados como archivos de texto delimitados por comas y pueden ser abiertos con numerosas aplicaciones. 
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Posiciones
 Las posiciones pueden usarse para destacar lugares de importancia o como waypoints de rutas. Asimismo las rutas
pueden abrirse como posiciones lo que permite reusar partes de la misma. 

Sin embargo, como las posiciones deben ser nombradas y no pueden cargarse nombres duplicados, podrían no cargarse
todos los waypoints. 

Para agregar una nueva posición haga click con el botón derecho sobre la posición correcta, seleccione Positions
(posiciones) -> Add (agregar), agregue la información y grabe con "save" (grabar). 

La edición de waypoints existentes puede hacerse seleccionándolo del panel de "Position" (posición) y luego haciendo
doble click sobre el mismo, o seleccionando Positions (Posiciones) -> Unlock (Desbloq.) en el menú superior. Luego es
posible arrastrar una posición (waypoint) y hacer doble click sobre ella para abrir la caja de edición o borrar posiciones
haciendo click con el botón derecho del mouse sobre la misma. 

Rutas 

Introducción 

Una ruta es una colección de waypoints conectados con información de velocidad y XTE (cross track error), usada para
asistir en la navegación. Cuando se activa una ruta se muestra un panel de ruta en el panel general ("dashboard").

 

Creación de rutas 

Las rutas se crean y modifican con el editor de rutas. Para iniciar el editor de rutas seleccione "Tools (Herrs.) - Route
Editor (Editor de Rutas)" en el menú superior. El panel general (dashboard) cambiará con información sobre el
waypoint seleccionado, aparecerán botones de acceso rápido y se reemplazará  el menú superior (contextualmente). 

El cursor cambiará al modo de inserción de rutas:    o al modo de extensión de rutas:  
Los waypoints se crean haciendo doble click con el botón izquierdo del mouse o usando las posiciones ya grabadas de
la base de datos. 
Durante el modo de inserción (predeterminado), un waypoint podrá insertarse entre los 2 waypoints existentes más
cercanos. En el modo de extensión, un waypoint se agregará al final de una ruta. 

Los waypoints pueden moverse posicionando el cursor sobre el mismo, presionando el botón izquierdo del mouse y
arrastrándolo hasta la nueva localización. 
Edite la información del waypoint ingresándola en el panel de waypoint del "dashboard" (panel general). 
Pueden seleccionarse múltiples waypoints presionando la tecla Ctrl (control) y haciendo click en cada waypoint para
seleccionarlo o deseleccionarlo, o presionando Shift (mayúsculas) para seleccionar todos los waypoints desde el actual
hasta el próximo seleccionado. Los waypoints seleccionados pueden ser editados o borrados. Si se editan múltiples
waypoints no pueden cambiarse las posiciones y los valores vacíos o "0" no son actualizados. 
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Durante la edición de rutas el panel general ("dashboard") se ve como a continuación: 

Menú superior de rutas.
Datos del waypoint seleccionado.

Lista de waypoints.
Latitud del waypoint.
Longitud del waypoint.

Velocidad estimada.

Cross track error (error de desvío lateral de derrota) máximo.

Nombre del waypoint.
Actualizar con los datos incorporados.
Borrar waypoint seleccionado.

Botones de acceso rápido.

Agregar la posición seleccionada a la ruta.

Base de datos de posiciones (waypoints).

Estadísticas de la ruta cargada.

Cuando se selecciona un waypoint de la lista, queda seleccionado y centrado en la pantalla. Si no se encuentra en la
carta actualmente cargada, se cargará la mejor carta. 

Nota: Durante la edición de rutas, la información sobre el barco continúa actualizándose desde el GPS. 
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Navegando con SeaClear 

Antes de iniciar un viaje, deberían cargarse las rutas necesarias. Luego es posible dejar al SeaClear sin atención,
permitiendo tener más tiempo para otras tareas. 

Durante la navegación debería conectarse el modo AUTOMATICO. La carta se reposiciona para mantener el barco a la
vista, se cargan nuevas cartas a medida que se necesiten y el barco permanece siempre visible en la pantalla. 
Si una ruta está cargada debería ser activada, para que muestre toda la información. 
Si el derrotero (tracking) está conectado, se mostrará en pantalla la derrota (track) hecha por el barco y la misma se
grabará en disco. 
En modo AUTOMATICO el cursor es la flecha predeterminada del sistema. 

Usando rutas 

Antes de iniciar un viaje cargue las rutas necesarias y actívela. Varias rutas pueden combinarse y cada ruta nueva será
automáticamente insertada en la mejor posición o extenderá las rutas actualmente cargadas. Si se presiona la tecla shift
(mayúsculas) en el cuadro de apertura de rutas pueden seleccionarse varias rutas. 
Cuando se activa la ruta si la posición actual se encuentra en la última pierna de la ruta cargada, se revertirá
automáticamente. Si la posición actual no se encuentra al inicio o al final de la misma, se calculará el mejor punto de
inicio. 

Cuando una ruta está activada el waypoint objetivo actual (próximo waypoint) se destacará y cambiará el panel de
información (dashboard) para mostrar informaciones que ayudan a la navegación. Se dispone de un botón "NMEA
OUT" (SALIDA NMEA), que inicialmente está en estado apagado. Cuando se lo conecta (presiona) los datos de la ruta
son transmitidos a un dispositivo que acepte sentencias NMEA. En el cuaderno de propiedades se selecciona qué se
transmite. 

La siguiente información se muestra en el "dashboard" (panel de información): 

Nombre del waypoint.
BWR:  marcación al waypoint.Línea de Rumbo.
XTE:  Cross Track Error (desvío lateral de la derrota deseada).
BOD:  marcación desde el origen hasta el destino.
WCV:  velocidad de aproximación al waypoint.
RNG:  distancia al waypoint.
TTG:  tiempo estimado hasta el waypoint.
TRNG: distancia por recorrer hasta el final de la ruta.
TTTG: tiempo restante desde la posición actual, usando los datos de veloci-
      dad del waypoint.
NEXT: muestra la próxima marcación.
TIME: tiempo transcurrido desde la activación de la ruta.

indicador de rueda de timón, mostrando cómo seguir la ruta.
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Para alternar entre rumbos verdaderos y magnéticos selecciónelo haciendo click con el botón derecho del mouse sobre
el panel de información de ruta. 

Si el máximo error XTE es excedido, la parte del panel del XTE se torna roja. Si en el cuaderno de propiedades se
seleccionó reconocer nuevo waypoint, cuando se alcanza el primer waypoint y el próximo waypoint está activado, el
panel de ruta se torna rojo hasta que el nuevo waypoint es reconocido, lo que debe ser hecho a través del teclado o
abriendo el menú emergente del panel de ruta. 

Cuando el modo automático está conectado y una ruta está activada no está disponible el menú superior, el panel de
"Posición" queda oculto y no es posible la edición. La mayoría de las teclas de acceso rápido continúan activas. Es
posible hacer uso del nivel de aumento (zoom), y puede cargarse una carta de escala menor para permitir una mejor
vista general. Si la posición cambia se recarga la mejor carta dentro de los 20 segundos. 

Para desactivar una ruta en forma prematura (cuando todavía no se alcanzó el final de la misma), se debe abrir el menú
emergente de ruta y hacerlo desde allí. 

Tracks (derrotas) 

Cuando está activada la función de derrotero se graba en disco la derrota del barco y se la muestra en la carta. Se graba
fecha, hora, posición, rumbo y velocidad de la misma. El intervalo de grabación de una posición de la derrota se
selecciona en el cuaderno de propiedades. La fecha actual en formato ANSI es el nombre del archivo que se genera
automáticamente, así el archivo de track (derrota) 20020304.TRC corresponde al 4 de marzo de 2002. Si el Datum
cambia durante la grabación de la derrota, la misma se distribuirá sobre dos archivos. Cuando la grabación de la derrota
está desactivada ("TRACK (derrota) NO" ó "TRACKING OFF") los archivos de derrotas pueden abrirse, mostrarse en
pantalla, imprimirse o exportarse como archivos de texto. Los archivos de derrotas también pueden usarse para crear
rutas. 

Logbook (bitácora) 

La bitácora electrónica es un archivo de texto en el que se graba la hora, la posición y un mensaje, pudiendo utilizársela
para realizar anotaciones manuales o para registrar eventos específicos en forma automática. La misma puede ser vista
mediante cualquier editor de texto. El nombre del archivo de bitácora y su ubicación en el disco se selecciona en el
cuaderno de propiedades. 
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Grupos de Cartas 

Para organizar las cartas SeaClear permite el agrupamiento de las mismas. El agrupamiento de cartas es opcional. 
Todas las cartas se usan con la misma preferencia si no se definieron grupos. Durante la búsqueda de cartas la misma
ocurre primero dentro de los grupos seleccionados. Si no se encuentran cartas preferidas durante una búsqueda de cartas
preferidas se buscará entre todas las cartas existentes. Si se encuentra alguna carta en un grupo preferido, sin importar
qué escala tenga, ésta será seleccionada. 

Pueden crearse hasta 24 grupos. Cada carta puede ser incluida en uno o más de cualquiera de los grupos. 

Los grupos son usados para las búsquedas de cartas, la selección de las cartas preferidas en la modalidad de autocarga y
la carga de las mismas durante la planificación. 

Los grupos preferidos para el modo de carga automática y para planificación son independientes para permitir el uso de
distintas cartas en el modo de planificación sin afectar las preferidas para el modo de autocarga. 

Definiendo y usando grupos de cartas 

Para definir grupos y seleccionar cartas use el menú superior Tools (Herrs.)->Chart Groups (Grupo de Cartas) para abrir
el cuadro de organización de grupos de cartas 

Para poder usar los grupos primero deben ser definidos en la solapa (pestaña) Instalación de Grupos (Groups Setup). 

Seleccione las cartas que estarán dentro de un grupo en la solapa Organizar las Cartas (Organize Charts). Pueden
seleccionarse varias cartas usando las teclas Ctrl y Mayúsculas (shift) o manteniendo el botón del mouse (ratón)
apretado mientras se mueve por la lista de cartas. 

La selección de las cartas preferidas para autocargarse se debe hacer en la solapa Cargar Grupos Automáticamente
(Autoload Charts). Cuando está activado el modo automático, también puede usarse la selección de cartas preferidas a
través del menú emergente. 

Usando grupos de cartas 

Cuando el modo automático esté activado, las cartas serán seleccionadas de los grupos de autocarga preferidos.
Solamente si no se encuentran cartas dentro de los grupos preferidos se usarán otras cartas. La selección de cuáles
grupos son los preferidos puede hacerse usando el item "Preferred Charts" ("Cartas Preferidas") del menú emergente. 

En el modo de planificación, con "Automático NO" ("Automatic Off"), con el item "Cartas Preferidas" ("Preferred
Charts") del menú emergente puede seleccionarse un grupo de cartas preferidas separado (distinto del seleccionado en
el modo automático). De este modo puede usarse un grupo de cartas diferentes, mientras se está planificando, al hacer
doble click sobre la carta. 

Utilice Cartas (Charts)->Buscar (Search) en el menú emergente para hacer una búsqueda avanzada de cartas sólo en los
grupos seleccionados. 

Para tener todas las cartas activadas, deseleccione todos los grupos preferidos. 

Los modos automático, de planificación y de búsqueda usan grupos preferidos separados. 
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Se muestran los bordes de las cartas preferidas tanto sobre la pantalla como en las impresiones. Para que se muestren
los bordes de todas las cartas, no sólo las preferidas, se deben deseleccionar todos los grupos en el cuadro de Cartas
Preferidas del menú emergente. 

Si se incorporan nuevas cartas con MapCal no serán incluidas automáticamente en algún grupo pero pueden ser
adicionadas manualmente. Si no se seleccionaron grupos preferidos igualmente pueden usarse. 

Los menúes Cartas (Charts)->En Posición (On Position) y Listar TODAS (List All) mostrarán todas las cartas
disponibles sin tener en cuenta los agrupamientos.
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Menúes 

Los menúes disponibles cambian de acuerdo al modo de operación en que se esté. En los modos de planificación se
dispone de un menú superior donde se pueden seleccionar la carga de archivos y otras tareas no relacionadas con la
posición. 

Los menúes emergentes, que se activan mediante el botón derecho del mouse (ratón), proveen un acceso rápido a varias
funciones. La posición donde se activa el menú emergente es considerada. 

Menú superior en modo de planificación normal 

Menú Archivos (File) 

Cartas (Charts): 
v Listar todas (List All): lista todas las cartas en el listado de carga automática. 

v Buscar  (Search): abre el cuadro de búsqueda avanzada. 

v Ultima (Last): carga la carta anterior. 

v No Listadas (Not Listed): abre cartas que no se encuentren en el listado de carga automática. Debe ser una carta calibrada. 

v Bordes (Outline): dibuja las líneas exteriores de todas las cartas disponibles sobre la carta actualmente cargada. Son
dibujadas sólo las cartas que se encuentren en la base de datos de carga automática. Serán dibujadas las líneas exteriores de
las cartas de la misma escala o de hasta 2 a 50 veces la escala actual (lo que es determinado en el cuaderno de propiedades).
Las líneas exteriores son los bordes grabados con las cartas y tendrán la forma y dirección de como fueron grabados. Si las
cartas se agruparon solamente se dibujarán los bordes de las cartas preferidas. 

v Imprimir Carta (Print): imprime una copia en papel de la carta actual. Las opciones de qué imprimir incluyen rutas,
posiciones, derrotas y bordes. Las opciones de rutas y posiciones tienen tres estados cuando no son impresos los grises y
etiquetas de texto marcadas. El área a imprimir puede ser tanto la carta entera como la porción actualmente visible en
pantalla. La orientación de la impresión se determina para maximizar el área impresa, ignorando lo que esté determinado en
las opciones de la impresora. 

v Imprimir Lista (Print List): Imprime una lista completa de todas las cartas incluyendo las esquinas y la escala. 

Rutas (Route): 
v Abrir (Open): abre una ruta nueva. Se pueden seleccionar varias rutas presionando Ctrl (tecla control) y seleccionando las

cartas con el mouse (ratón). 

v Limpiar (Clear): Borra la ruta de la memoria. 

v Exportar NMEA (Export NMEA): envía todos los waypoints sobre el puerto NMEA como archivos de WPL (waypoint) y
RTE (ruta). 

v Imprimir (Print): imprime una copia en papel de las rutas cargadas. 

Posiciones (Position): 
v Abrir (Open): pueden abrirse numerosos archivos (presione Ctrl y seleccione con el mouse para ello). Es de notar que no

pueden cargarse nombres duplicados, solamente la primer ocurrencia de un nombre duplicado será cargada. 
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v Grabar (Save) 

v Grabar Como (Save As) 

v Limpiar (Clear): limpia (borra) todas las posiciones de la memoria. 

v Desbloquear (Unlock): permite la selección, arrastre y borrado de las posiciones, individualmente (esto no es posible de
realizar cuando está activado el modo AUTOMATICO o el modo de edición de rutas). 

v Borrar Selección (Delete Selected) 

v Importar WP+ (Import WP+): importar un archivo de Waypoint+. 

v Exportar WP+ (Export WP+) 

v Exportar NMEA (Export NMEA): envía todas las posiciones en el puerto NMEA como archivos WPL (waypoint). 

v Imprimir (Print): imprime una copia en papel de todas las posiciones cargadas. 

Derrotas (Tracks): 
v Abrir Derrota Anterior (Open Old Track): abre y muestra en pantalla una derrota grabada con anterioridad en el disco. 

v Importar WP+: convierte un archivo de derrotas (tracks) de WP+ al formato de SeaClear. 

v Exportar Texto (Export Text): graba la ruta mostrada en pantalla actualmente como un archivo de texto delimitado por
comas. Son grabados los datos de hora, posición, velocidad y profundidad. Las posiciones son grabadas en grados decimales
para que puedan ser importadas fácilmente en otros programas. 

v Imprimir (Print): imprime en papel la derrota cargada. Puede ser una derrota activa o una anterior. 

Info Carta (Chart Info): muestra información de la carta cargada actualmente. 

Salir (Exit):Cierra SeaClear 

Menú Herrs. (Herramientas) (Tools Menu) 

Modo Nocturno (Night Mode): selección del nivel de sombreado. 1 es sin sombreado y 4 es el máximo sombreado. 

Editor de Ruta (Route Editor): abre el editor de ruta. 

Propiedades (Properties): abre el cuaderno de propiedades. 

Grupos de Cartas (Charts Groups): abre el cuadro de organización de los grupos de cartas. 

Sistema (System): 
v Monitor Entrada NMEA (NMEA Input Monitor): abre o cierra la ventana del monitor de entrada de sentencias NMEA. 

v Monitor Salida NMEA (NMEA Output Monitor): abre o cierra la ventana del monitor de salida de sentencias NMEA. 

Acerca de... (About...): abre la ventana de acerca de... SeaClear. 

>> Oculta el panel de información (dashboard) para permitir que toda la pantalla esté disponible para la
presentación de cartas. Para volverlo a ver nuevamente, mueva el mouse (ratón) hacia el borde de la pantalla. 
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Menú superior del Editor de Rutas 

Menú Archivos (Files): 

Rutas (Route): 
v Abrir (Open): abre una ruta nueva. Pueden seleccionarse varias rutas presionando Ctrl y seleccionándola con el mouse. 

v Grabar (Save): graba con el nombre de archivo actual. Si están abiertas varias rutas no existe un nombre de archivo
seleccionado actualmente. 

v Grabar Como (Save As): grabar como una ruta nueva. 

v Importar Track (derrota) (Import Track): importar una derrota grabada anteriormente. 

v Importar WP+ (Import WP+): importar un archivo generado por el programa Waypoint+. Debe estar en el formato de texto
de WP+. 

v Exportar WP+ (Export WP+): exportar un archivo con el formato de texto de Waypoint+. 

v Exportar NMEA (Export NMEA): envía sentencias WPL y RTE a un dispositivo NMEA conectado. 

v Listar Ruta (List Route): abre una ventana donde se listan todos los waypoints de la ruta y sus características. 

v Revertir (Reverse): hace que el punto de inicio de la ruta cargada sea el de fin de la misma. 

v Borrar Ruta (Clear Route): remueve todos los waypoints de la ruta cargada. 

v Imprimir (Print): imprime en papel las rutas cargadas. 

Abrir Carta (Open Chart): 
v Listar Todas (List All): muestra todas las cartas registradas en la lista de carga automática. 

v Ultima (Last): abre la carta abierta anteriormente. 

v No Listada (Not Listed): abre una carta que no se encuentra en la lista de carga automática. 

v Bordes (Outline): activa o desactiva la graficación de los bordes de las cartas. Se grafican sólo las cartas que se
encuentran en la base de datos de carga automática. 

Abrir Posiciones (Open Positions): abre una nueva base de datos de posiciones (waypoints). 

Cerrar Editor (Close Editor). 
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Menúes Emergentes 

El botón derecho del mouse (ratón) activa los menúes emergentes. La posición en la cual un menú emergente es
activado es usada para funciones posición dependientes. Algunas funciones de los menúes superiores están duplicadas
para permitir un acceso más rápido. 

Menú emergente principal 
Cartas Preferidas (Preferred Charts): seleccione la escala preferida que desee tanto en los modos automático y de
planificación y grupos de cartas preferidas cuando hace doble click para elegir la mejor carta. Si el modo automático
está activado se muestran los grupos preferidos de carga automática. Se elegirá la escala más próxima. Utilice las teclas
cursor arriba / abajo para cambiarla, "M" determina la máxima escala, Esc cierra el cuadro de selección sin grabar los
cambios. "Mejor Carta" (Best Chart) del menú todavía continúa seleccionando la carta de mayor escala disponible. 

Cartas (Charts): (no está disponible en el modo automático) 

v Mejor Carta (Best Chart): encuentra y carga la mejor carta, basándose en la posición actual. 

v Hallar Barco (Find Boat): encuentra la mejor carta para la posición del barco. 

v Escala Menor (Smaller Scale): selecciona una carta en la misma posición pero de menor escala. 

v Anterior (Previous): cambia a la carta cargada anteriormente. 

v En Posición (On Position): son listadas todas las cartas disponibles alrededor de la posición actual. 

v Buscar (Search): abre el cuadro de diálogo de búsqueda avanzada. 

v Listar Todas (All Charts): lista todas las cartas instaladas. 

Rutas (Routes): 
v Abrir Ruta (Open Route): se listan todas las rutas grabadas. 

v Revertir Ruta (Reverse Route): revierte la ruta convirtiendo el waypoint de inicio en el de fin. 

v Activar Ruta (Activate Route): activa la ruta y muestra el panel de información de ruta en el panel de información general
(dashboard). 

Posiciones (Positions): 
v Agregar (Add): agrega un waypoint en la posición actual del cursor. 

v Agregar Posic. Actual (Add Current Pos.): agrega un waypoint en la posición actual del barco. 

v Marcar Cursor (Set Marker): pone una marca en la posición actual del cursor del mouse (ratón). 

v Borrar Marca (Clear Marker): borra la marca. 

v Cuando se establece una marca: el panel de "Marcas/Cursor" mostrará la posición, distancia y valor de marcación desde el
barco. 

Zoom (nivel de aumento): aumentar o disminuir el tamaño de visualización a un porcentaje definido. En algunos
sistemas el aumento del nivel de visualización retardará la actualización de la pantalla en forma dramática, en otros es
instantánea. 

Herramientas (Tools): 
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v Anotar en Bitácora (Log Book Entry): permite hacer una anotación manual en la bitácora electrónica. 

v Derrota Anterior (Old Trace): muestra derrotas viejas o anteriores sobre las cartas (nota del traductor: esta función de
menú se desplazó a Archivos -> Tracks -> Abrir Derrota Anterior del menú superior). 

v Det. Posic. DR (DR Update): permite actualizar la posición del barco a la posición donde se encuentra actualmente el cursor
del mouse. No tiene uso si está conectado un GPS. 

v Refrescar Pantalla (Refresh Screen): refrescar / actualizar pantalla. 

v Propiedades (Properties): abre el libro de propiedades del sistema, para determinar las opciones de usuario. 

v Salir (Exit): sale de SeaClear. 

MARCAR MOB (MARK MOB): M(an) O(ver) B(oard) (hombre al agua). Establece la marca en la posición actual
del barco. 

Menú Emergente de Rutas 
Cuando se presiona el botón derecho del mouse (ratón) al estar activado el modo de edición de rutas, se dispone de las
siguientes selecciones: 
  

v Mejor Carta (Best Chart): encuentra la mejor carta para la posición del cursor del mouse (ratón). 

v Más Cartas (More Charts): lista otras cartas. 

v Extender (Extend): todos los waypoints serán adicionados al final de la ruta. 

v Zoom: seleccionar el nivel de aumento. 

Nota: algunas funciones no están disponibles cuando el modo automático está activado o cuando una ruta está activada. 
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Atajos de Teclado 

Comandos de control por teclado usando Ctrl + 'tecla' o las teclas de función 
  
  

Marcar MOB (Man Over Board = Hombre al Agua).  Ctrl + espacio 
Brillo nocturno.   Ctrl + '4' 
Brillo para crepúsculos.   Ctrl + '3' 
Brillo para días nublados.   Ctrl + '2' 
Brillo normal.   Ctrl + '1' 
Mostrar / ocultar el panel de datos/información (Dashboard).   Ctrl + 'D' 

Activar / desactivar la graficación de los bordes de las cartas.   Ctrl + 'O' ó
F12 

Ultima carta   Ctrl + 'V' ó F11 

Carta de menor escala (en modo automático permanece por 20 segundos si
está en movimiento).   Ctrl + 'S' ó F10 

Hallar el barco en la carta actual (se cargará la mejor carta si la posición
del barco no se encuentra en la carta actual).   Ctrl + 'F' 

Hallar el barco y la mejor carta.   Ctrl + 'B' ó F9 
Escala de carta preferida.   Ctrl + 'C' ó F8 
Anotación en la bitácora.   Ctrl + 'L' ó F7 
Borrar marca. (Ctrl + 'M' = establecer una marca).   Ctrl + 'H' ó F6 

Reconocimiento de nuevo waypoint (si se seleccionó de esta forma en el
cuaderno de propiedades).   Ctrl + 'N' ó F5 

Activar / desactivar la salida de AP (piloto automático)   Ctrl + 'P' ó F4 
Activar / desactivar el modo de grabación de derrota (track) - derrotero   Ctrl + 'T' ó F3 
Activar / desactivar el modo automático   Ctrl + 'A' ó F2 
Más zoom (aumentar el nivel de aumento)   Ctrl + 'Z' 
Menos zoom (bajar el nivel de aumento)   Ctrl + 'X' 
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Configuración 

General 
Las opciones de configuración pueden cambiarse en el cuaderno de propiedades al que se accede desde el menú
emergente o desde el menú superior. 
La instalación de las cartas digitalizadas y de los directorios debe hacerse en el programa MapCal. 

Pantalla (Display) 

Barco (Boat): 
v Intervalo de Actualización (Update Interval): intervalo de actualización de la posición del barco en la pantalla. 

v Color: color del barco y de la marca de velocidad. 

v Tamaño (Size): tamaño de la marca del barco. 

v Anillos de Radar (Radar Rings): número de anillos de radar visibles. 

v Distancia de los Anillos (Ring Step): distancia entre los anillos o seleccione Auto para una distancia que se adapte
automáticamente para que entre en la pantalla. 

v Marca de Velocidad (Speed Marker): número de segundos hacia adelante para la marca de velocidad. Seleccione 0 para
desactivar esta función. 

Idioma (Language): 
v Archivo de idioma (Language File): seleccione el archivo que contiene el idioma de su interés. Ver la sección Idioma. 

Display: 
v Panel de Información (Dashboard): seleccione si se presenta a la izquierda o a la derecha. 

v Zoom con Ruedita (Zoom with Wheel): activar / desactivar. 

v Mirar hacia adelante: activar / desactivar. Para posicionar la mayor parte de la pantalla delante del barco. Si se lo desactiva
la carta es posicionada con el barco en el medio de la pantalla. 

v Actualizar al Mover (Update while Panning): (archivos mapeados desde disco). Actualizar la pantalla mientras se arrastra
con el mouse (ratón). 

v Cursores Gruesos (Fat Cursors): usar cursores de mayor tamaño, más visibles en pantalla. 

Cartas (Charts): 
v Preseleccionar la Mejor Carta (Chart Prefetch): número de segundos que se mira hacia adelante para seleccionar la mejor

carta en modo automático. 

v Mejor Carta en los Bordes (Scroll Edge): borde de la carta donde al hacer doble click con el mouse (ratón) se buscará la
mejor carta. 

v Zoom para Nuevas Cartas (New Chart Zoom): 100% o el último. 
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Rutas (Route) 

Próximo Waypoint (Next Waypoint): 
v Pre Cargado (Pre-Load): tiempo antes de llegar al waypoint en el que se activa el próximo waypoint. 

v Máx Camino Erróneo (Wrong Way Max.): si el barco está tomando una senda diferente de la ruta determinada, la
distancia en que el waypoint actual debe moverse en la dirección errónea antes de que la ruta sea reactivada, encontrando un
nuevo inicio de ruta. 

v Reconocer Nuevo WP (Acknowledge New WP): si se selecciona, el panel de ruta se tornará rojo hasta que se reconozca el
nuevo waypoint. El reconocimiento se realiza haciendo click con el botón derecho del mouse (ratón) sobre el panel de ruta o
mediante el teclado. 

Valores Predeterminados para Rutas (Route Default): 
v Velocidad (Default Speed): la velocidad predeterminada cuando se introduce un nuevo waypoint. 

v Máximo XTE (Default XTE): el error XTE máximo predeterminado cuando se introduce un nuevo waypoint. 

Presentación de Rutas (Route Display): 
v Color Normal (Normal Color): color a usar en la presentación normal de los waypoints. 

v Color de Selección (Selected Color): color a usar en la presentación resaltada de los waypoints. 

v Tamaño (Size): tamaño de las marcas (de los waypoints de ruta). 

v Ancho de Línea (Line Width): ancho de las líneas que conectan los waypoints de ruta. 

v Mostrar Info de los Waypoints (Show Waypoint Info): muestra sobre la carta el nombre del waypoint si está disponible. 

Bitácora + Derrota (Logbook + Track) 

Intervalo de Derrotas (Tracking Interval): 
Selecciona la periodicidad en que la posición del barco es escrita en el archivo de grabación de derrota. 

v Tiempo Mínimo (Min. Time): entre cada grabación. 0 para deshabilitarlo. 

v Distancia Mínima (Min. Distance): en metros. 0 para deshabilitarla. 

v Cambio en el Compás (Compass Change): en grados. 0 para deshabilitarlo. 

Todos los parámetros, que no sean 0, deben ser excedidos antes de que una nueva posición sea grabada. 

Mostrar Derrota (Track Display): 
v Color de Track (Track Color) 

v Ancho de Track (Track Width) 

Bitácora (Log Book): 
v Entradas Automáticas (Automatic Entries): lo que se agregará a la bitácora en forma automática. 

v Archivo de Bitácora (Log Book File): archivo en el que se graba la bitácora. 

Instrumentos (Instruments) 
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Panel de Profundidad (Depth Display): 
v Mostrar Profundidad (Show Depth): activar / desactivar. 

v Alarma de Profundidad (Depth Alarm): si la profundidad es menor que este valor, el panel de profundidad avisará. 

v Prof. del Transductor (Trans. Depth): profundidad a la que se encuentra el transductor. Se suma a la profundidad antes de
mostrarla en pantalla.

Panel de Viento (Wind Display):  

v Mostrar Datos del Viento (Show wind information): activado / desactivado. 

v Color de la Flecha (Arrow Color): seleccionar el color para la flecha que indicará en la carta la velocidad y la
fuerza del viento. 0-1 M/s es punteada, 1-4 M/s es delgada entera, 4-8 M/s es de un ancho 2 de pixels, 8-12 es de un
ancho de 3 pixels, >12 flecha gruesa de 4 pixels de ancho.  

Panel de Compás (Compass Display): 
Muestra los datos de un compás NMEA conectado. 

Registro de Distancias (Log Data): 
Usa el GPS para el cálculo de la distancia acumulada y parcial recorrida. 

v Mostrar Dist. Acumulada y Parcial (Show Log and Trip): los datos adicionados se muestran en el panel de GPS. 

v Corte del Registro (Log Cut Off): si la velocidad es menor a la consignada, no se actualizan los datos de distancias parcial y
acumulada 

Actualización de DR por NMEA (NMEA DR Update): 
Si el GPS falla y se dispone de datos NMEA para velocidad y compás, actualizará el panel DR. El cálculo de la
posición del barco será hecho por SeaClear para estimar las posiciones hasta que el GPS esté trabajando. 

Nota: los datos de profundidad, viento y compás requieren sentencias NMEA con información, si no no se mostrarán. Son decodificadas las sentencias
NMEA DPT, MWV, MWD, VWR, VHW, HDG. 

Comm 

Conexión NMEA (NMEA Connection): 
v Puerto PC (PC Port): Comm 1 - 9. Usados tanto para recibir como para transmitir. 

v BPS: selección de la tasa de transferencia de datos. 4800 es el valor predeterminado para NMEA. 

Datum Seleccionado en el GPS (GPS Datum): 
El datum geodésico seleccionado en el GPS. Seleccionar de la lista el correspondiente al GPS. 

Pasaje de Sentencias NMEA (NMEA Pass-through): 
Las sentencias recibas que deben ser reenviadas a la salida NMEA. Asegúrese que no sean pasadas las sentencias
generadas por SeaClear. Las sentencias serán transmitidas sin importar la selección que se haya hecho de Salida NMEA
activada / desactivada. 

Salida NMEA (NMEA Output): 
Cuando una ruta está activa y se ha activado la Salida NMEA, los datos calculados de la ruta se transmitirán a ésta. 

v Sentencias (Sentences): seleccione qué sentencias enviar a un piloto automático, radar u otro dispositivo NMEA conectado,
dependiendo de las capacidades de éstos. WPL + RTE sólo son transmitidas cuando una ruta está activada, todas las otras
sentencias de acuerdo al valor consignado en el intervalo de actualización. Si se usa la opción "Exportar NMEA" desde
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Archivos -> Rutas o desde Archivos -> Posiciones los datos serán transmitidos sin importar lo que se haya seleccionado en
Salida NMEA. 

v Capac. del Objetivo (Target Capability): como los nombres de los waypoints son filtrados antes de ser transmitidos
"Mayúsculas (Upper Case)" debería funcionar con la mayoría de las unidades que acepten entrada de sentencias NMEA. "+
Minúsculas (Lower Case)" permite caracteres ASCII por debajo de 128. "Cómo es (As Is)" transmite todas las sentencias en
el standard de 8 bits ANSI de Windows. "Numérico (Numeric)" sólo envía Id (identificación) numérica del waypoint y
debería funcionar aún con viejas unidades que soporten entrada de datos NMEA. Esta selección también afecta qué es
transmitido con la opción Exportar NMEA de los menúes rutas y posiciones y qué es grabado con la opción Exportar WP+. 

v Intervalo de Actualización (Update Interval): con qué frecuencia los datos NMEA son transmitidos. 

v Factor ampl. XTE (XTE Ampl. factor): el error XTE enviado al piloto automático puede ser amplificado para permitir un
mejor seguimiento de la derrota o disminuido para evitar el zigzagueo. Un valor de 100% es 1:1. 

v NMEA Id: identificación del transmisor NMEA, habitualmente de 2 caracteres. Normalmente "EC" o "GP". 

v Mantener Id WP (Keep WP id): seleccionado / no seleccionado. Si está seleccionado se usarán nombres fijos de waypoints
para todas las piernas. Puede ser necesario con algunos receptores. Puede causar que los receptores cambien al próximo
waypoint sin la necesidad de reconocerlo. 

Otros (Other) 

Aviso Sonoro (Sound Warning): 
Utiliza el archivo de sonido especificado en el archivo .ini como aviso sonoro. 

Al Iniciar (Startup): 
v Actualizar Reloj Sistema c/GPS (Set System Time): usar el GPS. Actualiza la hora del sistema desde el GPS al inicio. 

v Cargar Ultimos Waypoints (Load Last Positions): cargar las posiciones de la última sesión, aunque no se hayan grabado. 

v Cargar Ultima Ruta (Load Last Route): cargar la ruta de la última sesión, aunque no se haya grabado. 

Posiciones (Positions): 
v Color Normal (Normal Color): color para la presentación normal de los waypoints. 

v Color de Selección (Selected Color): color para la presentación resaltada de los waypoints. 

v Tamaño (Size): tamaño de las marcas. 

v Mostrar Info de Posición (Show Position Info): mostrar el nombre de los waypoints sobre la carta. 

Modo Nocturno (Night Mode): 
Determina el nivel de sombreado y qué sombrear. 

v Nublado, Crepúsculo, Noche (Twilight, Dusk, Night): determina el nivel de sombreado, en %, de cada modo cuando se lo
selecciona. Un número desde -95 hasta 95, donde 0 es sin sombreado y 95 el máximo. Un número negativo invertirá los
colores antes de sombrear. 

v Sombrear el Escritorio (Desktop): también sombrea el escritorio de Windows. 

Esquema de Bordes de las Cartas (Chart Outline): 
v Color: cambia el color de presentación de los bordes de las cartas. 

v Máximo Factor de Escala: qué bordes de cartas presentar. Si el valor es 20, los bordes de las cartas en escalas de 1-20 veces
la escala actual serán graficados. 
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Instalación de Cartas 

MapCal 
El utilitario MapCal se utiliza para instalar nuevas cartas y recalibrar las existentes. 

Una carta raster consiste de una imagen y de datos de calibración que permiten traducir una posición en la imagen a una
posición geográfica. Se necesitan, como mínimo, 2 puntos de calibración. Puede utilizarse una grilla superpuesta para
verificar la calibración. Puede crearse un borde de carta que contenga al área utilizable de la misma y que es usada para
la selección automática de la mejor carta. Tanto la grilla como los bordes son graficados utilizando la proyección
seleccionada. 

Con archivos PNG y BMP los datos de calibración deben guardarse en un archivo externo, mientras que los archivos
con extensiones WCI, BSB/KAP y GEO/NOS tienen incorporados dichos datos. Los archivos BSB/KAP y GEO/NOS
están precalibrados y no pueden cambiarse con el utilitario MapCal. Sin embargo es posible y abrir y revisar la
calibración. La versión previa de SeaClear usaba un tipo diferente de calibración, que puede ser importada al nuevo
formato. 

Los archivos .map del utilitario OziExplorer pueden ser convertidos incluyendo los datos de imagen e información de
calibración. Es de notar que como los archivos .map no contienen algún dato original de escala, dicha escala se estima a
partir de los metros por pixel. Solamente pueden importarse los archivos .map que hacen referencia a un archivo de
imagen válido. Para permitir la importación de la mayoría de los formatos de archivos de imágenes, los datos de
calibración y la imagen son importados al formato WCI. 

Pueden ser importados los archivos .chi de calibraciones de cartas WinGPS. Como las imágenes son en formato BMP,
directamente reconocidas por SeaClear, se crea un archivo de calibración en el mismo directorio del archivo .chi. Luego
de la importación todas las imágenes pueden abrirse directamente, incluyendo los datos de calibración. 

MapCal también puede convertir numerosos tipos de imágenes a formato WCI para ser usadas en SeaClear. Formatos
de archivos BMP, PNG, TIF, JPG, PCX y muchos otros pueden convertirse. Es necesario destacar que SeaClear no
soporta todos esos formatos de archivos y para poder utilizarlos deben ser convertidos a formato WCI en MapCal. Si se
dispone de datos de calibración se incorporan en el archivo WCI resultante. 

Los archivos WCI pueden convertirse a BMP, incluyendo los datos de calibración, permitiendo la edición o cualquier
otra manipulación de la imagen y su ulterior reconversión a WCI, preservando la calibración. 

Se utiliza una base de datos que contiene todos los datos y escala de las todas las cartas para permitir la carga
automática de las mismas. Esta base de datos se crea en MapCal y debe ser actualizada si se realiza cualquier cambio en
las calibraciones de las cartas existentes o si se agregan cartas nuevas. También se verifica la validez del datum de las
cartas. 

Guía de instalación de cartas 
Se requieren los siguientes pasos para instalar una carta en SeaClear (para instalar una carta BSB, ver más abajo). 

1: Haga una carta utilizando un scanner o mediante capturas de pantallas. Actualmente SeaClear soporta las siguientes
proyecciones: Grilla Fija (Fixed Grid), Mercator,  Mercator Transversal (Transverse Mercator), Policónica, Lambert
Cónica Conforme y cartas proyectadas Ortográficamente, Sinusoidalmente y de Perspectiva Vertical de borde cercano.
También se soportan proyecciones basadas en Mercator Transversal tales como UTM o Gauss. La mayoría de las
proyeccciones funcionan bien en áreas pequeñas, como las normalmente usadas en navegación. Pueden utilizarse la
mayoría de los scanners de escritorio. El color es agradable. Al digitalizar realice pruebas de digitalización para obtener
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el mejor contraste y asegúrese de tener la carta alineada. Verifique que las líneas de longitud o de latitud sean paralelas
a los bordes de la pantalla. El archivo debería estar en formato de paleta de colores (256 colores máximo) y guardado en
formato .BMP o .PNG sin comprimir. El formato .PNG generalmente produce archivos más pequeños pero es un poco
más lento para cargarse. El formato .BMP no funciona con los modos nocturnos, por lo tanto el formato .PNG es el que
se recomienda usar si la imagen no se convierte a WCI. 
Múltiples digitalizaciones o capturas de pantallas pueden unirse para hacer una carta más grande. Se recomienda
utilizar resoluciones de 100 - 250 DPI. Un tamaño de 2000 * 2000 pixels usará 4 MB de memoria cuando se cargue,
mientras que el espacio de disco utilizado variará según el formato de archivo elegido.  Debería usarse un máximo de
265 colores, pero con el formato .PNG, como está comprimido, el número de colores no hace demasiada diferencia.
Grabe el archivo en un directorio que esté en el path charts del SeaClear. 

2: Inicie MapCal_2.EXE. Si usa el formato WCI use las opciones de menú Tools->Convert->Single File to WCI para
convertir la imagen a WCI antes de calibrarla. 

3: Localice su archivo, original o WCI, abriéndolo con "File->Open Image". 

4: Utilice "Edit->Chart Information" para ingresar el nombre, escala, proyección y datum de la carta; el resto de la
información es opcional (este cuadro emerge automáticamente al abrir imágenes no calibradas). Si se utiliza Lat Shift o
Long Shift (Lat. Camb. o Long. Camb.) los valores consignados sobrepasarán la selección del datum de la carta. Latitud
0 es cero para la mayoría de las cartas, mientras que Longitud 0, el meridiano central de la proyección Mercator
Transversal, Policónica, Lambert y Sinusoidal, es una longitud predeterminada cercana a la carta. Si no la conoce déjela
en 0 para permitir a MapCal seleccionar un meridiano central apropiado. Si se selecciona la proyección Lambert se
pedirán los paralelos standard norte y sur, seleccione 0 si son desconocidos para dejar que MapCal seleccione el
predeterminado.  Para las proyecciones Ortográfica y de Perspectiva Vertical de borde cercano los parámetros deben
incorporarse correctamente, ya que las estimaciones normalmente resultan en parámetros incorrectos. El item Priority
se utiliza para la carga automática, siendo 1 la mayor prioridad de carga. Una prioridad (Priority) de 10 será igual que la
mitad de la escala, así una carta de escala 25.000 con prioridad 10 será igual que una carta de escala 50.000 con
prioridad 1. 
Si no desea que una carta se cargue automáticamente pero quiere que aparezca en el listado de cartas use un número
alto para la prioridad. 

5: Coloque por lo menos 2 marcas sobre la carta en posiciones conocidas, lo más separadas y cercanas a esquinas
opuestas posible y luego introduzca las coordenadas de las mismas. Excepto para las proyecciones de grilla fija o
Mercator normalmente son necesarios 3 puntos como mínimo. Coloque el cursor en la posición correcta y haga click
con el botón derecho del mouse (ratón) para agregar un punto de calibración (add a calibration point). Utilice los
botones de flecha, que se encuentran en el panel, para realizar un ajuste fino de la posición de los mismos. Agregue los
datos correctos de Latitud y Longitud. 

6: Presione "Activate Changes" (activar cambios) (los pasos 2 y 3 pueden hacerse en indistinto orden). Ahora se
mostrará la grilla en la densidad seleccionada. Para cambiar el color de la grilla, haga click en el cuadrado de color. Si
la grilla coincide perfectamente, la calibración está hecha. Si la grilla no coincide seleccione cada marca desde la lista
"Calibration Points" (puntos de calibración), muévalos con las flechas de dirección N/S y E/W según sea necesario o
agregue marcas adicionales. Tendrá las coordenadas geográficas ya anotadas, por lo tanto sólo muévalas con las flechas
o arrástrelas con el mouse (ratón). Presionando "Activate Changes" mostrará cómo se ve con la grilla. Esto hará más o
menos lo mismo que el viejo "skewing" (en MapCal), excepto que se debe apretar el botón "Activate Changes" para
activar el cambio. La calibración debe ser correcta antes de pasar al paso 7, ya que los bordes de la carta se guardan en
coordenadas geográficas. 

7: Haga click en la solapa "Border" para crear los bordes de la carta. Los puntos (marcas) de los bordes se agregan igual
que los puntos de calibración, haciendo click con el botón derecho del mouse (ratón). O presione "Set Border to Image"

                                                                                                                                           Seaclear MM II - Manual en español

  J. P. P.                                                                                                                                                                       Página 23



(seleccionar borde para la imagen) para obtener un borde con un margen de 5 puntos. Esto se realiza automáticamente
durante la grabación si no se agregaron los bordes en forma manual. 

8: Grabe su calibración con "File->Save Calibration". 

Esto debería ser todo lo que necesita hacer. Luego de calibrar cartas nuevas, convertir calibraciones anteriores, agregar
cartas precalibradas como las BSB/KAP o cambiar el path del directorio charts, es necesario actualizar o crear nuevas
listas de carga automática para que las cartas nuevas sean cargadas automáticamente en SeaClear. 

Referencias de MapCal 
Menú "File": 
v Open Image: abre cualquier archivo de imagen. Si se dispone de datos de calibración también son cargados. 

v Open From List: encuentra un archivo por nombre usando la lista de carga automática. 

v Save Calibration: graba los datos de calibración (si existen). 

Menú "Edit": 
v Chart Information: abre el cuadro de información general de la carta. Agregue la escala, proyección y datum de la carta; el

resto de la información es opcional. Vea el paso 4 más arriba - este cuadro se abre automáticamente cuando se cargan
imágenes nuevas. 

Menú "Tools": 

  El menú "Convert" es para la conversión de formatos de imágenes. 
v Convert -> Current to WCI: convierte la imagen cargada al formato WCI, incluyendo la calibración. 

v Convert -> Current WCI to BMP: convierte la imagen WCI cargada al formato BMP, incluyendo la calibración. 

v Convert -> Single file to WCI: la mayoría de los tipos de imágenes pueden convertirse a WCI, incluyendo muchos formatos
que no pueden ser abiertos por MapCal o SeaClear. Pueden ser imágenes no calibradas. 

v Convert -> Images in Dir to WCI: convierte todos los archivos de imagen que se encuentran en el directorio. Las imágenes
pueden no estar calibradas, ya que la calibración puede ser cambiada sobre los archivos WCI. 

v Convert -> MAP in Dir to WCI: convierte todos los archivos de imágenes y MAP de OziExplorer en archivos WCI
calibrados. 

  El menú "Import Cal" es para importar datos de calibración a un formato utilizable. 
v Import Cal -> Old SeaClear Calibration: importa todas las calibraciones de cartas encontradas. Los paths deben ser

seleccionados y el archivo seachart.dir debe encontrarse en el directorio actual. Se sobreescribe cualquier nueva calibración
existente. 

v Import Cal -> CHI Calibrations: importa todos los datos de calibración de un archivo .chi de WinGPS. 

  El menú "Autoload List" es para actualizar el archivo SCAINDEX.BIN. 
v Autoload List -> Scan for New Charts: busca nuevas cartas en los directorios de cartas (charts) 

v Autoload List -> Update: busca calibraciones cambiadas y verifica si hay nuevas en los directorios de cartas. Cualquier
carta no encontrada se dejará como está (en caso que en el path Ud. también tenga un CD y el CD no esté insertado en el
CD-ROM drive). 

v Autoload List -> Recreate: borra el archivo SCAINDEX.BIN y genera uno nuevo, verificando todos los directorios que
figuren en el path de cartas. Sólo las cartas encontradas estarán en la lista. 
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El menú "Maintenance".  

v Remove Unused Calibrations: remueve cualquier calibración no activa remanente luego de borrar del directorio
imágenes sin datos de calibración incorporados. 

El menú "Set Directories" es usado para determinar todos los paths de archivos usados por MapCal y SeaClear 

v Set Directories: instala todos los paths necesarios (determina los directorios). Actualiza el archivo SEACLEAR_2.INI. 

Menú "<<" 
Oculta el panel de información maximizando el área de trabajo. Para volver a mostrarlo, mueva el mouse (ratón) sobre
el borde izquierdo de la pantalla. 

Instalación de cartas precalibradas 
Seaclear tiene soporte interno para la lectura de archivos normales BSB/KAP y GEO/NOS, por lo que no es necesaria
ninguna conversión. Estos deben ser registrados para que se muestren el las listas de cartas y puedan ser usados para la
carga automática. Imágenes no registradas pero calibradas pueden abrirse en SeaClear con la selección de los menúes
"Archivos -> Cartas -> No Listadas" (File->Charts->Not Listed). 

Instalación de cartas BSB 
El formato de archivo BSB/KAP es licenciado por Maptech. Se soportan las versiones 1 - 3 de BSB/KAP. Solamente
las proyecciones Mercator, Mercator Transversal, Policónica, Lambert Cónica Conforme, Sinusoidal y Ortográfica son
soportadas actualmente. 

Las cartas están disponibles para muchas áreas mundiales en Maptech, NDI y muchas otras fuentes. La carta corriente
está en un archivo KAP, mientras que el archivo BSB solamente contiene datos de cobertura y similares. Dado que
SeaClear guarda su propia base de datos, los archivos BSB no son necesarios. 

Las cartas BSB/KAP deberían ser registradas antes de usarlas en SeaClear: 

1. Inicie MapCal y asegúrese de que todos los archivos KAP están en el directorio de charts (cartas). 

2. Desde el menú superior seleccione "Tools -> Autoload List -> Scan for New Charts". Los archivos KAP se revisarán para
encontrar nombre, cobertura y otros datos y serán listados en la base de datos de autocarga de SeaClear. 

Instalación de cartas GEO/NOS 
Solamente proyecciones Mercator, Mercator Transversal, Policónica, Lambert Cónica Conforme, Sinusoidal y
Ortográfica se soportan actualmente. 

La carta corriente se encuentra en un archivo NOS, mientras que el archivo GEO contiene datos de calibración,
cobertura y similares. Ambos archivos, GEO y NOS,  son necesarios y deben encontrarse en el mismo directorio. 

Antes de utilizar cartas GEO/NOS en SeaClear éstas deberían ser registradas: 

1. Inicie MapCal y asegúrese que todos los archivos GEO y NOS están en el path de charts (cartas). 

2. Desde el menú superior seleccione "Tools -> Autoload List -> Scan for New Charts". Los archivos GEO se revisarán para
encontrar nombre, cobertura y otros datos  y serán listados en la base de datos de carga automática de SeaClear. 
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Instalación de cartas WCI 

1. Inicie MapCal y asegúrese que todos los archivos WCI están calibrados correctamente y en el path de charts (cartas). 

2. Desde el menú superior seleccione "Tools -> Autoload List -> Scan for New Charts". Los archivos WCI se verificarán para
encontrar nombre, cobertura y otros datos y serán listados en SeaClear. 

Debido a que los archivos WCI, KAP y NOS son mapeados desde el disco, la lectura desde un CD resultará en bajas
performances por lo que se recomienda grabarlos en el disco duro. 
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Referencias 
  

Instalación de SeaClear 

Instalación en el disco duro 
Si está instalando desde un archivo .ZIP, cree un directorio base y extraiga los archivos del programa. También necesita
crear directorios para cartas, rutas, waypoints y derrotas y consignar estos paths en el archivo .INI para que coincidan.
Los directorios predeterminados son "CHARTS" (cartas), "ROUTES" (rutas), "TRACES" (derrotas) y "WAYPTS"
(waypoints) en el directorio base: 

<Directorio Base>: 
SeaClear_2.Exe 
MapCal_2.Exe 
Datums2.Ini 
<Directorio Base>\Charts: 
World.WCI 
Med.WCI 
USA.WCI 
Sweden.WCI 
<Directorio Base>\Routes: 
(Ponga las rutas acá) 
<Directorio Base>\Traces: 
(Las derrotas serán grabadas aquí) 
<Directorio Base>\Waypts: 
(Ponga los archivos de waypoints -posición- aquí) 

Además se crearán automáticamente los archivos SCAINDEX.BIN y SEACLEAR_2.INI 

Cargando SeaClear desde un CD 
SeaClear puede cargarse desde un CD pero, como el CD es de solo lectura, nada puede grabarse. El archivo
"SEACLEAR_2.INI" en forma predeterminada debe estar en el mismo directorio que los ejecutables de SeaClear, por
lo tanto se recomienda dejarlos en el disco duro. Es de notar que las cartas que se mapean desde el disco tendrán una
performance muy baja si se leen desde un CD. 

Sin embargo, dado que las cartas ocupan muchos MB, es posible cargar SeaClear desde el disco duro pero mantener
éstas en CD. 
Copie todos los archivos menos las cartas al disco duro. 
Asegúrese que los atributos de todos los archivos permitan la lectura/escritura, por ej. deshabilite "solo lectura". 
Cree los directorios de "Traces", "Routes" y "Waypts". 
Si recibe SeaClear en un CD, una forma fácil de hacer esto es instalar SeaClear y luego borrar el directorio "Charts". 
Utilice MapCal para instalar los directorios. 
Alternativamente, usando la línea de comando /l????, el archivo .ini luego de l puede ser usado para mantener todos los
archivos en CD, excepto el archivo .ini, permitiendo grabar ciertas opciones. 
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Usando múltiples directorios de cartas (charts) 
Como el CD es lento, las cartas que se usen con más frecuencia pueden grabarse en un directorio del disco duro dejando
otras en el CD mediante el uso de un path estilo DOS: 
"Chart Dir=C:\SEACLEAR\CHARTS\;D:\MYCHARTS\;D:\MOREMAPS\" 

Todas las cartas encontradas en los directorios C:\SEACLEAR\CHARTS, D:\MYCHARTS y D:\MOREMAPS,
cuando arranque SeaClear, se mostrarán en los listados de cartas. 

Las cartas que no estén en el path determinado también pueden usarse si se utiliza el path completo con el nombre
durante la instalación de las mismas con MapCal. 

Desinstalar 
Todos los archivos instalados y creados están en el árbol de directorio de SeaClear. No se crea ningún archivo fuera del
directorio base de SeaClear. Para remover SeaClear simplemente borre los directorios de SeaClear y los accesos
directos. Con la versión full de instalación use "Agregar/Remover Programas" del Panel de Control de Windows. 
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Información Técnica 

La Computadora 
Una PC bajo Windows XP/2000/NT ó 95/98/ME. Windows XP/2000/NT es una mejor elección debido a algunas
limitaciones en 95/98/ME, evitando algunos pequeños problemas y permitiendo trabajar con cartas de mayor tamaño
sin inconvenientes. 
Una pantalla de 800 * 600, preferentemente de 1024 * 768 para que entre más información en el panel (dashboard). 
Mouse (ratón) 
1 puerto serial libre para el GPS. 
Un procesador Pentium o similar. 
32 MB de RAM mínima. 64 MB (dependiendo del SO) es recomendable y acelera la carga de cartas. 
Los archivos PNG son lentos para cargar y requieren mucha memoria, por lo que es recomendable un Pentium con 64
MB. 
10 - ???? MB de espacio libre en disco (3 MB para SeaClear y 10K - 10MB / carta). 

Cada carta puede ser un bitmap grande. Si Windows está instalado con más de 256 colores los bitmaps creados usarán
más memoria y disminuirán el rendimiento del sistema. Por lo tanto se recomienda seleccionar Windows a 256 colores,
aún cuando el subsistema de video permita mejor calidad. Esto es particularmente importante en Windows 95/98/ME y
con los archivos PNG, ya que al ser desempaquetados ocupan un tamaño mucho mayor en memoria que en disco. Con
cartas que se mapean de disco (WCI & KAP) solamente se carga la parte visible de las mismas, por lo que no se verán
tan afectadas por la selección de colores de Windows. 

Como todas las versiones de Windows tienen una limitación de 32K sobre las imágenes el tamaño de carta máximo es
de 32K * 32K y también es el máximo tamaño que pueden aumentarse, por lo tanto solamente las cartas de menos de
8K * 8K pixels se pueden aumentar 400%. 

La impresión de cartas grandes pueden requerir Windows NT/2000 o superior. 

Conectando un GPS 
El GPS debe ser capaz de transmitir sentencias NMEA 0183 RMC, RMA o GGA / GLL & VTG. Si el GPS permite
seleccionar distintas versiones de NMEA 0183, seleccione NMEA 2.0. Las versiones anteriores a la 0183 pueden
funcionar, pero no están bien probadas. 
Consulte la documentación de su GPS para ver cómo conectarlo a una PC. Como el protocolo NMEA especifica la
configuración de datos del puerto serial, normalmente no se precisa más configuración que seleccionar el puerto de PC
correcto. El GPS se conecta a Rx y Tierra en la PC. 

En un conector de 9 pines (DB9), comúnmente usado en las laptops, Pin 2=Rx, 3=Tx, 5=Ground (tierra). 

Conectando un receptor NMEA 
Un receptor NMEA, como un piloto automático, debe ser capaz de aceptar sentencias NMEA APA, APB, RMB, BOD,
BWC, WPL o RTE. Consulte la documentación de cómo conectarlo a la PC. Como el protocolo NMEA especifica la
configuración de datos del puerto serial no se necesita otra configuración. El puerto es el mismo que el usado por el
GPS. El receptor se conecta a Tx y Tierra en la PC. Debido a que tanto el rumbo como el error XTE pueden
transmitirse, un piloto automático puede posicionar el barco muy cerca de la ruta activa. Las sentencias NMEA
recibidas también pueden incluirse en la salida. 
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Cálculos y precisión 
Los cálculos de rumbo y distancia se realizan usando la loxodromia (línea de rumbos). Todos los cálculos son hechos
con doble precisión, eliminando los errores matemáticos. Los cálculos de la línea de rumbos son menos precisos en
grandes distancias. Con usos normales, como la navegación en un archipiélago, los errores no son notables debido a que
son menos precisas la posición GPS y las cartas. 
SeaClear no funciona con cartas y rutas que traspasen la línea de fecha (180&deg; E/W). 

Formato de archivo WCI 
Se da soporte a un formato de archivo nativo, WCI (World Calibrated Image). Permite el mapeo desde el disco e
incluye datos de calibración mundial y puede ser creado desde sus imágenes existentes. Está bien comprimido en
general y permite recalibraciones. WCI es un formato de paleta, que permite hasta 256 colores, un tamaño máximo de
32767 * 32767 pixels y 1 GB. Puede utilizarse MapCal para crear archivos WCI. Solamente las imágenes de paleta
pueden convertirse. El formato está mejor adaptado para grandes cartas con no demasiados colores. Para un mejor
resultado las cartas tendrán que tener menos de 64 colores con áreas coloreadas grandes. 

Mapeo desde disco 
El mapeo desde disco se utiliza con archivos WCI, BSB/KAP y GEO/NOS permitiendo bitmaps muy grandes. Se
comprobó que archivos descomprimidos con tamaños de más de 150 MB funcionaron aún en sistemas con memoria
limitada. Dentro de lo posible, los archivos mapeados desde disco, no deberían estar en CD ya que los datos necesitan
ser leídos cada vez que se actualiza la pantalla. Cuando se aumenta el zoom puede notarse un leve cambio debido a que
la imagen debe alinearse con los datos originales y cada archivo cambiará debido a que la renderización comenzará
desde una nueva posición. 

Formatos de archivos 
SeaClear está diseñado para hacer un uso completo de los formatos de mapeo desde disco. Sin embargo pueden seguir
usándose imágenes PNG o BMP. Como las cartas requieren datos de calibración en el caso de los archivos de imagen
PNG y BMP éstos se guardan en un archivo separado en el mismo directorio que las imágenes, mientras que los
formatos KAP y WCI tienen los datos de calibración incorparados. El formato BMP genera archivos muy grandes y no
pueden ser ajustados para los modos nocturnos. El formato PNG tiene una buena compresión, normalmente. Las
imágenes PNG y BMP calibradas pueden convertirse a WCI. MapCal también puede convertir muchos otros formatos
de imágenes a WCI para usarlos con SeaClear. 

Variación Magnética 
SeaClear calcula automáticamente la variación magnética para la posición actual. El cálculo está basado en los datos
disponibles más actuales para obtener mejores resultados. Para deshabilitar el cálculo interno y usar los valores que
envía el GPS vea la sección de configuración del archivo SeaClear_2.INI. 

Modo Nocturno 

SeaClear puede ajustar la oscuridad de la carta si los formatos de archivos utilizados son PNG, WCI o KAP. Con el
formato PNG esto se realiza durante la carga y cambia la imagen antes de que sea mostrada en pantalla. Con los
formatos WCI y KAP se cambia la paleta actual, con lo que no es necesario que la carta sea recargada. 

                                                                                                                                           Seaclear MM II - Manual en español

  J. P. P.                                                                                                                                                                       Página 30



Pueden seleccionarse cuatro modos en el menú Sistema: Normal, Nublado, Crepúsculo y Noche (nota del traductor: en
esta versión de SeaClear puede hacerse desde los botones del panel de información). El modo normal es el común, sin
cambios, Los otros tres se configuran en el cuaderno de propiedades como un porcentaje de sombreado, donde 0
equivale a sin sombreado. Un número negativo invertirá todos los colores antes de producir el sombreado. 

El Escritorio de Windows también puede incluirse en el sombreado, esto se configura desde el cuaderno de
propiedades. 

Idioma 

Seleccionando un idioma 
En el menú de Sistema (arriba a la izquierda), "Seleccione Sistema" abre un cuadro de diálogo de archivos. Seleccione
el archivo de idioma. (Nota del traductor: en esta versión de SeaClear la selección del idioma se hace desde el cuaderno
de propiedades, sección archivo de idioma). La mayoría de los textos son traducidos y se graba la selección del idioma. 

Creación de archivos de idioma 
1: Utilice el archivo ENGLISH_2.LNG como un modelo y cópielo como su_idioma.lng 
2. Use un editor de texto como el Notepad para abrir el archivo. Todas las cadenas de texto tienen una clave y un valor:
'_Form.XTELabel.Hint=Crosstrack Error'. La clave es el texto que se encuentra a la izquierda del símbolo igual. No la
cambie. El valor es el texto que se halla a la derecha del símbolo igual. Muévase por el archivo y vaya traduciendo los
valores de texto según lo que desee. En los menúes, precediendo un carácter con "&" lo convertirá en un carácter de
atajo (subrayado en el menú). Si el texto comienza o finaliza con un espacio enciérrelo entre comillas, como a
continuación: _Form.TX_MESSAGES:lines.31=" no está grabado! Grabar?". No comience el texto con un dígito, - ó _. 
El encabezado "[Text_2]" debe ser la primera línea del archivo. 
Grabe el archivo con la extensión .lng 
3: Seleccione el archivo como se describió anteriormente. 
4. Revise que los textos reemplazados entren en el espacio disponible! 

Por favor, envíe su archivo de idioma traducido a seaclear@sping.com con el fin de que pueda ser incluido con la
distribución. 

Nota: Sólo pueden usarse caracteres ANSI. 
Nota: Puede crearse un nuevo modelo agregando "save:" delante del nombre del archivo (por ej. "save:C:\SC\LANG.LNG") en el cuaderno de
propiedades. En lugar de cargar el archivo, será creado (sin "save:"). Se incluirán todos los cambios actuales. 

  

Datums Geodésicos de las Cartas 

El GPS conectado debería configurarse para que transmita los datos de posición usando el datum WGS 1984. Si no es
así, seleccione el datum correcto en el diálogo del cuaderno de propiedades. Los datos de posición luego se traducirán a
WGS 1984. Todos los cálculos internos están basados en este datum. 

Cuando se usan cartas con datums distintos del WGS 1984 la misma es calibrada como siempre, alineando la grilla con
el datum de la carta. El datum seleccionado se lo consigna para traducir las localizaciones de la carta a WGS 1984 en
SeaClear. Se convierten todas las localizaciones, barco, posiciones, waypoints y derrotas. 

Todos los datums de cartas son almacenados en un archivo externo, Datums2.INI. Debido a que cartas pre- calibradas
pueden hacer referencia al mismo datum pero con otro nombre, se utiliza una sección para alias. Para agregar un alias,
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agregue una línea con "Nombre del datum alternativo=nombre en SeaClear" en la sección [DatumsAliases], donde
"nombre en SeaClear" es el nombre que se encuentra en la sección [Datums]. Durante la creación de la lista de carga
automática de cartas se verifica el datum de las mismas y como las cartas pre- calibradas pueden usar distintos nombres
para el datum un cuadro de diálogo muestra el nombre correspondiente para SeaClear. La relación se guarda en la
sección [DatumsAliases]. 

Nota: El sistema GPS está basado en el datum geodésico WGS 1984 y las traducciones de datums no son exactas. 
  

Proyecciones Cartográficas 

SeaClear da soporte a las proyecciones Mercator, Mercator Transversal, Policónica, Lambert Cónica Conforme,
Sinusoidal, Ortográfica, Perspectiva Vertical de borde cercano y de Grilla Fija. También se soportan otras proyecciones
basadas en Mercator Transversal como UTM, Gauss Krüger y muchas otras. 

La proyección se selecciona durante la instalación de la carta. Si el Meridiano Central es desconocido (Lon0) para una
proyección Transversal, generalmente funcionará usar el centro de la carta. La latitud de origen (Lat0) raramente es
distinta de 0. Para la proyección Lambert debe conocerse un paralelo norte y sur standard. Si se cambia la proyección
debe verificarse la calibración de la carta. 

Variaciones a las proyecciones Mercator, Mercator Transversal, Policónica, Lambert Cónica Conforme, Sinusoidal y
Ortográfica pueden agregarse en el archivo Datums2.INI. 

La sección [Projections] se utiliza para las proyecciones del usuario. 
Name=Base,Lat0,Lon0, LatS, LatN donde Name (nombre) es el nombre que se muestra en la lista desplegable; Base es
1 para Mercator, 2 para Mercator Transversal, 3 para Lambert, 4 para Policónica, 5 para Sinusoidal y 6 para
Ortográfica; Lat0 es la latitud de origen; Lon0 es el meridiano central.  Cuando es usada, la lista desplegable cambiará a
la proyección base y Lat0 y Lon0 se reemplazará con los valores consignados. 

Configuraciones del Archivo SeaClear_2.INI 

La mayoría de las configuraciones son actualizadas desde dentro de SeaClear. Sin embargo unas pocas selecciones
pueden establecerse con un editor de texto. 

Selecciones modificables del archivo INI 

Sección [Program State] 
La sección [Program State] es actualizada por SeaClear y no debería ser modificada, excepto para poner a cero la
distancia recorrida acumulada y el tiempo de uso. Para ello SeaClear no debe estar cargado. 

Para poner a cero el registro de distancia recorrida acumulada (log), borre la clave: 
Total Distance=XXXX 

Para poner a cero el tiempo de uso, borre la clave: 
Time Counter=XXXX 
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Sección [Program Setup] 
;Utilice los números de la carta en nombre (name). Para los archivos BSB/KAP y GEO/NOS, el número de la carta se 
;agregará al nombre de la misma. Es útil si las cartas tienen el mismo nombre pero con diferente número. 
;El valor predeterminado es 0, no usar números. 1 si se usan. Es usado por MapCal. Si se cambia debe recrearse la lista
de 
;carga automática de cartas. 
Use Chart Numbers=0 

;Cómo SeaClear maneja los checksums recibidos desde un dispositivo NMEA. Reinicie SeaClear si lo cambia. 
NMEACheckSum=1 
;0 = fuerza el uso de checksum, no acepta valores vacíos de checksum 
;1 = acepta valores vacíos de checksum, usa checksum si está disponible (por omisión) 
;2 = no verifique el checksum de NMEA 

;Archivo .wav de sonido de advertencia por omisión: 
;Si no se especifica un path, se asume que el archivo se localiza en el directorio Windows. 
Sound1=DING.WAV 
;Para reemplazar el sonido por omisión por otro archivo .wav: 
Sound XTE R=NombreDeArchivo  ; Para el sonido de advertencia de XTE a la derecha 
Sound XTE L=NombreDeArchivo  ; Para el sonido de advertencia de XTE a la izquierda 
Sound NMEA=NombreDeArchivo ; Para el sonido de advertencia de falta de datos NMEA 
Sound Dpt=NombreDeArchivo       ; Para el sonido de advertencia de profundidad 

;Para usar la Variación Magnética transmitida desde el GPS 
MagErr Calc=0 

;Puede capturar las sentencias NMEA seleccionadas en un archivo. Cualquier mensaje NMEA puede ser capturado, 
;aún aquellos no usados por SeaClear: 
NMEA_CAPTFILE=C:\NMEACAPT.TXT ; su archivo de captura 
NMEA_CAPTMSG=RMC,GGA,VTG,DBT ; sentencias capturadas. Utilice "*" para capturar todas las sentencias 

;Puede simular todos los datos del GPS desde un archivo. No es necesario que haya entrada de sentencias NMEA. 
NMEA_SIMUL=C:\NMEAINP1.TXT 

;Para cambiar el buffer de disco de los formatos WCI/KAP/NOS. El predeterminado es 1/8 de la RAM de la PC o un 
;máximo de 16MB en KB. Normalmente no debería modificarse 
Diskmap Buffer=16384 

;Para cambiar el tamaño máximo de las imágenes WCI cuando se carga en memoria la imagen completa. En forma 
;predeterminada es igual al buffer de mapeo de disco. Seleccionar 0 acelera el tiempo de carga inicial de cartas más
chicas 
;pero puede disminuir la velocidad de movimiento de la carta y el zoom. En KB. 
Diskmap ImageMem=16384 

Sección [Fuel Data] 
Puede estimarse el consumo de combustible. Consigne valores para la velocidad y el consumo de combustible / hora en
la sección [Fuel Data] de la siguiente manera: "velocidad=consumo_de_combustible". Tanto los valores de velocidad
como de consumo de combustible / hora deben consignarse multiplicados por 10, sin los decimales. La velocidad debe
anotarse con 3 dígitos incluyendo los ceros a la izquierda. Pueden consignarse hasta un máximo de 20 valores. Los 2
valores más cercanos se utilizan para calcular el consumo actual de combustible. El combustible (fuel) se muestra en el
panel de distancias y tiempo (log and time). Para deshabilitar la información de consumo de combustible en dicho
panel, renombre o comente (con ;) la sección [Fuel Data]. 
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Ejemplo: si el consumo de combustible de su barco es como sigue: 
2.8 l/h @ 0.0 Kt (regulando) 
4.5 l/h @ 5.0 Kt 
8.0 l/h @ 8.0 Kt 
22.5 l/h @ 14.0 Kt 
35.0 l/h @ 18.0 Kt 
65.0 l/h @ 25.0 Kt 

Ingrese los siguiente en el archivo INI: 
[Fuel Data] 
000=28 
050=45 
080=80 
140=225 
180=350 
250=650 

Argumentos de la línea de comando 
SeaClear reconoce los siguientes argumentos en la línea de comando: 
/lxxxx     donde xxxx es el nombre de archivo de un archivo INI alternativo, incluyendo todo su path. 
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Licencia de SeaClear 

A usted se le garantiza una licencia no exclusiva para usar el software SeaClear en tantas computadoras como desee,
sujeto a los siguientes términos y condiciones: 

1. SeaClear es un software propietario registrado. Sping asevera tener el derecho de ser reconocido como el propietario,
autor y dueño de los derechos de autor bajo la Ley Internacional de Tratados y Derechos de Autor. 

2. SeaClear se provee "como tal", sin garantía alguna, expresa o implícita. En ningún caso el autor será responsable por
daños ocasionados por el uso de este software. 

3. Leyes o regulaciones locales pueden restringir el uso de software de navegación electrónica. Siempre guíese por las
regulaciones locales y tenga las cartas originales y disponible el equipo de navegación apropiado cuando use SeaClear. 

4. SeaClear nunca debe enviar información a algún dispositivo que controle el barco en forma no atendida. 

Usted puede redistribuir el software de SeaClear a cualquier persona u organización por cualquier medio que desee, con
tal que: 

1. Por el suministro del software mismo de SeaClear no cobre más que un monto razonable por el manejo o costos de
producción de los medios de distribución. 

2. No asegure que tiene la representación de la autoría o algún otro título sobre el software SeaClear. 

3. Suministre el paquete de software de SeaClear completo y sin modificaciones, incluyendo este documento. 

SeaClear es sólo una ayuda a la navegación. Recopila, calcula y muestra datos por usted pero no existen
garantías de que sean correctos, existen muchas fuentes de error. SeaClear no es un reemplazo a los
conocimientos sobre navegación, ni puede navegar por sí solo. Uselo con precaución. Siempre tenga disponibles
las cartas originales cuando esté usando SeaClear. 

Traducción:   Ing. Agr.  Juan Pablo Pileggi - ( j_p2@uolsinectis.com.ar)

Buenos Aires, Argentina. Marzo/2002

Actualización 26/05/2002
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